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메뉴 화면의 기본 작동법

[MENU] 버튼을 누르면 메뉴 화면이 나타납니다. 메뉴 화면에는 5개의 메뉴가 포함되어 있으며, 이 화면에서 음색, 곡, 메트로놈/
리듬, 녹음 및 시스템(악기의 전체 설정)과 관련된 설정을 실시할 수 있습니다. 이 부분에서는 메뉴 화면의 기본 작동을 설명합니다.
다음의 경우 추가 설정을 실시한 후 메뉴 화면을 열어야 합니다.

• 음색 관련 파라미터를 편집하려는 경우
음색을 선택합니다. 듀얼/스플릿/듀엣 모드에서 음색을 편집하려는 경우 원하는 기능을 켭니다.

• 곡 관련 파라미터를 편집하려는 경우
곡을 선택합니다.

1. [MENU] 버튼을 몇 차례 눌러 원하는 메뉴를 선택합니다.
버튼을 반복해서 누르면 메뉴가 전환됩니다. 화면 상단에 표시된 메뉴 이름과 좌측의 아이콘은 선택한 메뉴를 표시합니다.

2. [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택합니다.

3. [l]/[r] 버튼을 사용하여 설정을 변경하거나 작업을 실행합니다.
CLP-885, CLP-875 및 CLP-895GP에서 선택된 항목을 기본값으로 재설정하려면 값이 재설정될 때까지 [MENU] 버튼을 길게 
누릅니다. CLP-845, CLP-835, CLP-865GP의 경우 [<] 버튼과 [>] 버튼을 동시에 누릅니다. 

4. 메뉴 화면을 종료하려면 [EXIT] 버튼을 누릅니다.

Voice 메뉴 3페이지
건반 연주 설정(페달 기능, 듀얼/스플릿/듀엣 모드의 음량 밸런스, 조옮김 등)을 
실시하거나 음색을 편집합니다.

Song 메뉴 9페이지
곡 재생 설정(반복 재생, 음량, 조옮김 등)을 실시하거나 곡을 편집하거나 곡 파일을 
처리합니다.

Metronome/
Rhythm 메뉴

16페이지
메트로놈 및 리듬 음량을 조절하거나 메트로놈 박자 기호를 설정하거나 리듬 관련 
설정을 실시합니다.

Recording 메뉴 18페이지 MIDI 관련 설정을 실시합니다.

System 메뉴 20페이지
전체 악기(튜닝, 음향, 오디오 파워 오프, 화면 밝기 등)에 대한 설정을 실시하거나 
USB 플래시 드라이브를 포맷하거나 악기 설정을 백업합니다.

885 875 895GP 845 835 865GP
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Voice 메뉴

Voice 메뉴를 사용하면 음색 파라미터 등의 건반 연주에 관한 다양한 파라미터를 편집하거나 설정할 수 있습니다. 건반을 연주하여 
소리를 들으면서 원하는 음향이 될 때까지 파라미터 값을 하나씩 변경하십시오. 듀얼, 스플릿 또는 듀엣 모드에서 음색 설정을 
실시할 때에는 Voice 메뉴를 불러오기 전에 반드시 듀얼, 스플릿 또는 듀엣을 끄십시오.

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정

Transpose 반음 단위로 전체 건반의 피치를 올리거나 내려 더욱 
쉽게 까다로운 조표를 연주하며 가수나 다른 악기의 
음역에 건반의 피치를 쉽게 맞출 수 있습니다. 예를 
들어, 이 파라미터를 “5”로 설정하는 경우 C 건반을 
연주하면 F 음이 납니다. 이와 같은 방식으로 F장조 
곡을 C장조처럼 연주할 수 있습니다.

주

• 여기에서 실시한 설정은 곡 재생에 영향을 미치지 않습니다. 
곡 재생을 조옮김하려는 경우 Song 메뉴의 “Transpose” 파라미터
(10페이지)를 사용하십시오.

• 오디오 녹음의 경우 여기에서 실시한 설정에 따라 조옮긴된 음향이 
녹음됩니다. MIDI 녹음의 경우 Song 메뉴의 “Transpose”(10페이지) 
값은 여기에서 실시한 설정에서 오프셋됩니다.

• 건반 연주 데이터는 조옮김된 음 번호와 함께 전송되지만 외부 MIDI 
장치나 컴퓨터에서 수신된 MIDI 음 번호는 조옮김 설정의 영향을 
받지 않습니다.

-12(-1 옥타브) – 
0(일반 피치) – 
+12(+1 옥타브)

0

Piano 
Setting
* 이 설정은 VRM 
이펙트가 존재하는 
피아노 음색에만 
적용됩니다.

Lid Position (가상) 그랜드 피아노 뚜껑이 열린 높이에 따른 음향의 
차이를 재현합니다.

Full, Half, Close Full

VRM VRM 이펙트를 켜거나 끕니다.

 VRM(가상 공명 모델링)
VRM(가상 공명 모델링) 기능은 정교한 물리적 모델링을 
사용하여 실제 피아노의 댐퍼 페달을 밟거나 건반을 연주하고 
있는 동안 발생하는 실제 현 공명 음향을 재현합니다. 실제 
어쿠스틱 피아노에서는 댐퍼 페달을 밟고 건반을 연주하면 
누른 건반의 현뿐만 아니라 다른 현과 공명판도 진동하여, 
각 현이 나머지 현에도 영향을 미치며 오래 지속되고 널리 
퍼지는 풍성하고 멋진 공명을 만들어냅니다. 본 악기에 탑재된 
VRM 기술은 가상의 악기(물리적 모델링)를 통해 현과 공명판 
모두의 공명에 대한 복잡한 상호 작용을 충실하게 재현하여 
실제 어쿠스틱 피아노와 매우 흡사한 음색을 표현합니다. 
건반이나 페달 상태에 따라 그 순간에 즉각적인 공명이 
발생하기 때문에, 건반을 누르는 타이밍과 페달을 밟는 깊이와 
타이밍에 변화를 주어 다양한 음색을 표현할 수 있습니다.

“VRM”이 “On”일 때 다음 파라미터를 원하는 대로 설정
합니다.

On, Off On

Damper Res.
(댐퍼 공명)

댐퍼 페달(오른쪽 페달)을 밟을 때 
적용되는 현 공명 이펙트의 깊이를 
결정합니다.

0 – 10 5
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Voice 메뉴
Piano 
Setting
* 이 설정은 VRM 
이펙트가 존재하는 
피아노 음색에만 
적용됩니다.

VRM Damper 
Noise

댐퍼 노이즈를 켜거나 끕니다. 이 
기능은 “Damper Res.”가 0으로 
설정된 경우 비활성화됩니다.

 댐퍼 노이즈
댐퍼 노이즈는 댐퍼 페달을 밟을 때 
어쿠스틱 피아노에서 생성되는 
음향입니다. 댐퍼 페달을 밟는 속도에 
따라 댐퍼 노이즈 음과 음량이 
변화합니다. 댐퍼 페달을 천천히 밟으면 
댐퍼 헤드가 현에서 해제될 때보다 
조용한 음향이 생성되지만 강하게 밟으면 
현으로 진동이 전달되므로 더욱 낮고 큰 
음향이 더해집니다.

On, Off On

String Res.
(현 공명)

건반의 한 음을 눌렀을 때 적용되는 
현 공명 이펙트의 깊이를 결정합니다.

0 – 10 5

Duplex 
Scale Res.
(듀플렉스 
스케일 공명)

VRM에서 듀플렉스 스케일링 공명 
이펙트의 공명을 조절합니다.

 듀플렉스 스케일
듀플렉스 스케일링은 높은 옥타브의 추가 
타현을 사용하여 음을 강화시켜주는 
피아노의 현 구성 방식입니다. 이러한 
현은 어쿠스틱 피아노의 다른 현과 공명 
진동하여 오버톤과 공명하기 때문에 
음향이 더욱 풍부해지고 밝아지며 
다채로워집니다. 댐퍼가 건반과 접촉하지 
않기 때문에 건반에서 손을 뗀 후에도 
음의 소리가 계속됩니다.

0 – 10 5

Body Res.
(바디 공명)

피아노 자체(공명판, 측면, 프레임 
등)의 공명을 조절합니다.

0 – 10 5

Grand Exp.
(Grand 
Expression 
Modeling)

실제 피아노의 물리적인 음향 전환을 재현하는 Grand 
Expression Modeling 이펙트의 형식을 선택합니다. 이 
기능을 “Dynamic”으로 설정한 경우 연주 강도, 터치 
또는 건반에서 손을 떼는 방식을 변경하여 연주 및 
음향의 매우 미묘한 뉘앙스를 제어할 수 있습니다. 
“Static”으로 설정하는 경우 일반적으로 뉘앙스가 
고정됩니다.

 Grand Expression Modeling
실제 어쿠스틱 피아노에서는 건반을 누른 후 손을 뗄 때까지 
연주 터치를 변경하여 미묘한 음향 변화를 생성할 수 있습니다. 
예를 들어, 건반을 끝까지 누르면 아래의 건반 받침에 부딪혀 
노이즈가 현에 도달하기 때문에 음향이 약간 변하게 됩니다. 
또한 댐퍼를 현으로 내려 음향을 음소거할 때의 음은 건반에서 
손을 떼는 속도에 따라서도 변합니다. Grand Expression 
Modeling 기술은 사용자의 연주에 반응하는 이 미묘한 음향 
변화를 재현합니다. 강하게 연주하여 액센트를 가미하거나 
부드러운 연주를 통해 공명을 추가하여 최상의 표현력 넘치는 
음향을 생성할 수 있습니다. 스타카토 주법으로 연주할 때에는 
산뜻한 음향이 들리며 건반에서 천천히 손을 뗄 때에는 오래 
지속되는 음향을 생성할 수 있습니다.

Dynamic, Static Dynamic

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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Voice 메뉴
Reverb 건반 연주, 곡 재생 및 외부 MIDI 장치에서 전송된 MIDI 
데이터 입력을 포함하여 모든 음향에 적용되는 리버브 
형식을 결정합니다.

• Off: 이펙트 없음

• Recital Hall: 피아노 독주회에 적합한 중간 규모 홀의 
뚜렷한 반향음을 재현합니다.

• Concert Hall: 대중적인 오케스트라 공연에 적합한 대규모 
홀의 화려한 반향음을 재현합니다.

• Chamber: 실내악에 적합한 소규모 실내의 우아한 
반향음을 재현합니다.

• Room: 방 또는 라운지 등 소규모 연주 공간의 부드러운 
리버브를 재현합니다.

• Cathedral: 천장이 높은 석조 성당의 장엄한 반향음을 
재현합니다.

• Club: 재즈 클럽이나 소규모 바의 생동감 있는 반향음을 
재현합니다.

• Plate: 녹음 스튜디오에서 사용되는 빈티지 리버브 장비의 
선명한 음향을 재현합니다.

(좌측 열 참조) (음색 또는 
음색의 조합에 
따라 다름)

Chorus 건반 연주, 곡 재생 및 외부 MIDI 장치에서 전송된 MIDI 
데이터 입력을 포함하여 모든 음향에 적용되는 코러스 
형식을 결정합니다.

• Off: 이펙트 없음

• Chorus: 풍부하고 넓은 공간성의 음향을 덧붙입니다.

• Celeste: 증감이 있고 넓은 공간성의 음향을 덧붙입니다.

• Flanger: 상승 또는 하강 중인 제트기 음향과 비슷한 증감 
이펙트를 더해줍니다.

(좌측 열 참조) (음색 또는 
음색의 조합에 
따라 다름)

Voice Edit 아래의 설정을 변경하면 선택한 음색의 음향을 원하는 대로 편집할 수 있습니다. 
듀얼, 스플릿 또는 듀엣이 켜지면 다중 음색 이름이 “Voice Edit” 화면에 표시됩니다. 대상 음색을 선택한 후 
편집합니다. 

• 듀얼이 On일 때: 상단열 = 음색 1, 하단열 = 음색 2
• 스플릿이 On일 때: 상단열 = 오른손 음색, 하단열 = 왼손 음색

• 듀얼과 스플릿이 On일 때: 상단열 = 오른손 1 음색, 중간열 = 오른손 2 음색, 하단열 = 왼손 음색

• 듀엣이 On일 때: 상단열 = 오른손 연주자 음색, 하단열 = 왼손 연주자 음색

Octave 옥타브 단위로 건반의 피치를 올리거나 내립니다. −2 – 0(피치 변경 
없음) – +2

(음색 또는 
음색의 조합에 
따라 다름)

Volume 선택한 음색의 음량을 조절합니다. 0 – 127

Reverb 
Depth

선택한 리버브 형식의 깊이를 조절합니다. 0으로 
설정하면 이펙트가 없습니다.

주
VRM 음색을 동시에 여러 파트에 사용하는 경우 예상치 못한 음향이 
발생할 수 있는데, 우선순위가 있는 파트의 리버브 깊이가 모든 파트에 
적용되기 때문입니다. 곡이 재생되는 동안에는 하나의 곡 파트에 대한 
설정이 사용(우선순위 순서: Ch. 1, Ch. 2...Ch. 16)되며, 곡 재생이 
중지되면 하나의 건반 파트에 대한 설정이 사용(우선순위 순서: R1, L, 
R2 음색)됩니다.

0 – 127

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP 참고 설명서 5



Voice 메뉴
Voice Edit Chorus 
Depth

선택한 코러스 형식의 깊이를 조절합니다. 0으로 
설정하면 이펙트가 없습니다.

주
VRM 음색을 동시에 여러 파트에 사용하는 경우 예상치 못한 음향이 
발생할 수 있는데, 우선순위가 있는 파트의 리버브 깊이가 모든 파트에 
적용되기 때문입니다. 곡이 재생되는 동안에는 하나의 곡 파트에 대한 
설정이 사용(우선순위 순서: Ch. 1, Ch. 2...Ch. 16)되며, 곡 재생이 
중지되면 하나의 건반 파트에 대한 설정이 사용(우선순위 순서: R1, L, 
R2 음색)됩니다.

0 – 127 (음색 또는 
음색의 조합에 
따라 다름)

Effect 이펙트 형식을 결정합니다. 리버브 및 코러스는 전체 
음향에 적용되며, 여기에서 선택한 이펙트는 선택한 
음색에만 적용됩니다. 이펙트는 VRM 음색에 적용되지 
않습니다.

• Off: 이펙트 없음

• DelayLCR: 왼쪽, 중앙, 오른쪽 위치에서 딜레이가 
적용됩니다.

• DelayLR: 왼쪽과 오른쪽 위치에서 딜레이가 적용됩니다.

• Echo: 에코와 유사한 딜레이입니다.

• CrossDelay: 왼쪽과 오른쪽 딜레이가 교대로 서로 
교차합니다.

• Symphonic: 풍부하고 깊은 음향 이펙트를 덧붙입니다.

• Rotary: 로터리 스피커의 비브라토 이펙트를 덧붙입니다.

• Tremolo: 음량 레벨이 빠른 주기로 변화합니다.

• VibeRotor: 비브라폰의 비브라토 이펙트입니다.

• AutoPan: 음향이 전후좌우로 이동합니다.

• Phaser: 주기적으로 위상이 변화하여 음향을 증감시킵니다.

• AutoWah: 와와 필터의 중앙 주파수가 주기적으로 
변화합니다.

• Distortion: 음향을 왜곡시킵니다.

(좌측 열 참조)

Rotary 
Speed

“Rotary”를 이펙트 형식으로 선택한 경우에만 이용 
가능합니다. 이 파라미터는 로터리 스피커 이펙트의 
회전 속도를 결정합니다.

Fast, Slow

VibeRotor “VibeRotor” 이펙트 형식으로 선택한 경우에만 이용 
가능합니다. 이 파라미터는 VibeRotor 이펙트를 켜거나 
끕니다.

On, Off

VibeRotor 
Speed

“VibeRotor” 이펙트 형식으로 선택한 경우에만 이용 
가능합니다. 이 파라미터는 Vibraphone 비브라토 
이펙트의 속도를 결정합니다.

1 – 10

Effect Depth 선택한 음색의 이펙트 깊이를 조절합니다. 특정 이펙트 
형식은 깊이를 조절할 수 없습니다.

1 – 127

Pan 선택한 음색의 스테레오 팬 위치를 조절합니다. L64(맨 왼쪽) – 
C(중앙) – R63
(맨 오른쪽)

Harmonic 
Cont
(하모닉 함량)

필터의 공명 값을 증가시켜 고유한 “피크” 톤을 
생성합니다.

주
하모닉 함량은 들을 수 있는 이펙트가 거의 없거나 일부 음색에 
적용되지 않을 수도 있습니다.

−64 – +63

Brightness 선택한 음색의 밝기를 조절합니다. −64 – +63

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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Voice 메뉴
페달 기능 목록

Voice 메뉴의 “Pedal Assign”에서 왼쪽, 중앙 및 오른쪽 페달 각각에 지정할 수 있는 기능의 목록입니다. 지정 가능 기능은 페달에 
따라 다릅니다.

Voice Edit Touch Sens.
(터치 감도)

건반을 누르는 힘(건반 연주 강도)에 따라 음량 레벨이 
변하는 정도를 결정합니다. 하프시코드 및 오르간과 
같은 일부 음색의 음량 레벨은 건반 연주 강도와는 
관계없이 변하지 않으므로 이 음색에 대한 기본 설정은 
127입니다.

0(가장 부드러움) 
– 64(가장 큰 
폭의 레벨 변화) 
– 127(건반의 
연주 강도와는 
관계없이 가장 큰 
음량 생성)

(음색 또는 
음색의 조합에 
따라 다름)

RPedal 선택한 음색의 오른쪽, 중앙 또는 왼쪽 페달의 기능을 
켜거나 끕니다. 이 파라미터는 예를 들어 스플릿이 
On일 때 페달 기능이 오른손 연주에는 영향을 미치나 
왼손 연주에는 영향을 미치지 않도록 할 때 유용합니다. 

On, Off

CPedal

LPedal

Pedal 
Assign

Right 오른쪽, 중앙 또는 왼쪽 페달의 기능을 변경합니다.

주
왼쪽 페달의 기본 설정은 특정 음색에 따라 다릅니다(“Jazz Organ 1”, 
“Jazz Organ 2” 또는 “Rock Organ” 음색의 경우 “Rotary Speed”, 
“Vibraphone” 음색의 경우 “VibeRotor”).

(아래의 페달 
기능 목록을 
참조하십시오.)

Sustain (Cont.)

Center Sostenuto

Left Soft

Balance
* 듀얼, 스플릿 또는 
듀엣이 On일 때 
이용 가능한 
파라미터만 
표시됩니다.

Volume 
R2 – R1

듀얼이 On일 때 두 음색 사이의 음량 밸런스를 
조절합니다. 슬라이더를 오른쪽으로 옮기면 오른손 1 
음량이 올라가지만 오른손 2 음량은 내려갑니다. 
왼쪽으로 옮길 경우 이와 반대가 됩니다.

R2+10 – 0 – 
R1+10

(음색 또는 
음색의 조합에 
따라 다름)

Volume 
L – R

스플릿 또는 듀엣이 On일 때 오른쪽과 왼쪽 부분 
사이의 음량 밸런스를 조절합니다. 슬라이더를 
오른쪽으로 움직이면 오른쪽 부분 음량이 올라가지만 
왼쪽 부분 음량은 내려갑니다. 왼쪽으로 움직이면 이와 
반대가 됩니다.

L+10 – 0 – R+10

Detune 듀얼 모드에서 오른손 1 음색과 오른손 2 음색을 디튠
하여 보다 두터운 음향을 만들어 냅니다. 슬라이더를 
오른쪽으로 움직이면 오른손 1 음색 피치가 올라가지만 
오른손 2 음색 피치는 내려갑니다. 왼쪽으로 움직이면 
이와 반대가 됩니다.

R2+20 – 0 – 
R1+20

기능 설명 지정 가능 또는 불가능
(: 지정 가능, –: 지정 불가능)

왼쪽 페달 중앙 페달 오른쪽 페달

Sustain (Switch) 건반에서 손을 뗀 후에도 페달을 밟고 있으면 연주하는 음을 
지속시켜 주는 기능

  

Sustain (Cont.) 건반에서 손을 뗀 후에도 페달을 밟고 있으면 연주하는 음을 
지속시켜 주는 기능. 서스테인 길이는 페달을 밟는 정도에 따라 
달라집니다.

– – 

Sostenuto 건반의 한 음 또는 코드를 연주할 때 해당 음을 누른 상태에서 
페달을 밟으면 페달을 밟고 있는 동안 해당 음이 지속됩니다. 
그 이후에 누르는 음은 지속되지 않습니다. 

  

Soft 음량을 줄이고 페달을 밟는 동안 연주하는 음의 음색을 약간 
바꿔줍니다.

  

PitchBend Up 피치를 부드럽게 올립니다. – – 

PitchBend Down 피치를 부드럽게 내립니다. – – 

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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Voice 메뉴
주

• 현악기, 오르간과 같이 특정 음색의 경우 (댐퍼/소스테누토 기능이 지정된) 페달을 밟을 때 음향이 계속 지속될 수 있습니다.
• [PLAY/PAUSE] 기능이 System 메뉴의 “Pedal” > “Play/Pause”(22페이지)를 통해 페달에 지정되는 경우 여기에서 지정된 해당 페달의 기능이 비활성화됩니다.

Rotary Speed 페달을 밟을 때마다 (Jazz Organ 1, 2 또는 Rock Organ 음색의) 
로터리 스피커 속도를 “Fast”와 “Slow” 사이에서 전환합니다.

  

VibeRotor 페달을 밟을 때마다 (Vibraphone 음색의) 비브라토를 켜거나 
끕니다.

  

기능 설명 지정 가능 또는 불가능
(: 지정 가능, –: 지정 불가능)

왼쪽 페달 중앙 페달 오른쪽 페달
CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP 참고 설명서 8



Song 메뉴

Song 메뉴를 사용하면 곡 재생과 관련된 다양한 파라미터를 설정하고 곡 데이터를 편집할 수 있습니다. 작업을 시작하기 전에 
원하는 곡을 선택하십시오.
이용 가능한 파라미터는 MIDI 곡과 오디오 곡 간에 차이가 있습니다. “(Audio)”로 표시된 다음 파라미터는 오디오 곡을 선택한 
경우에만 설정할 수 있으며, “(MIDI)”로 표시된 파라미터는 MIDI 곡을 선택한 경우에만 설정할 수 있습니다. “Edit” 파라미터는 
내장곡 및 음색 데모곡에 설정할 수 없습니다.

주의사항
”Execute”는 현재 곡 데이터를 편집하거나 변경하는 기능입니다. [r] 버튼을 누르면 본래 데이터가 새 데이터로 대체됩니다. 

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정

Volume
(Audio)

선택한 오디오 곡의 음량을 조절합니다. 0 – 127 100

Repeat
(Audio)

곡 재생을 위한 반복 모드를 선택합니다.

• Off: 반복 재생을 비활성화합니다. 선택한 곡 재생이 
끝부분에 이르면 재생이 자동으로 멈춥니다.

• Single: 선택한 곡만 반복해서 재생합니다.

• All: 선택한 곡이 포함된 폴더의 모든 곡을 숫자 순으로 계속 
재생합니다.

• Random: 선택한 곡이 포함된 폴더의 모든 곡을 무작위 
순으로 계속 재생합니다.

반복 유형을 Off 이외의 다른 모드로 선택한 경우 상태 
아이콘(Single: , All: , Random: )이 Song 
화면의 우측 상단에 표시됩니다.

Off, Single, All, 
Random

Off

L / R
(MIDI)

R 선택한 MIDI 곡의 각 파트를 켜거나(재생) 끕니다(음소거). 
데이터가 없는 파트의 경우 “---”가 표시되고 해당 파트를 
켜거나 끌 수 없습니다.

주
MIDI 곡은 16개의 트랙(파트)으로 구성되어 있으며, 보통 트랙 1은 
“R”로, 트랙 2는 “L”, 트랙 3~16은 “Extra”로 지정됩니다.

On, Off On

L

Extra

Repeat
(MIDI)

A – B 선택한 MIDI 곡의 지정 범위(A지점에서 B지점까지)를 
반복 재생할 수 있습니다.
1. [PLAY/PAUSE] 버튼을 눌러 곡의 재생을 

시작합니다.

2. 반복될 범위의 시작점(A)에서 [r] 버튼을 누릅니다.

3. 종료점(B)에서 [r] 버튼을 다시 누릅니다. 
(프레이즈로 안내할 수 있는) 자동 도입부 이후 
A지점에서 B지점의 범위가 반복 재생됩니다.

구간 반복을 비활성화하려면 “Repeat Off”를 선택한 
상태에서 A-B Repeat 화면의 [r] 버튼을 누릅니다. 
다른 곡을 선택해도 구간 반복이 비활성화됩니다.

주

• 시작점(A)으로 곡의 처음을 지정하려면 A지점을 지정한 후 재생을 
시작하십시오.

• 종료점(A)으로 곡의 끝을 지정하려면 곡이 끝날 때까지 쭉 
재생하십시오. 지점 B는 버튼을 누르지 않아도 자동으로 설정됩니다.

On, Off Off
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Song 메뉴
Repeat
(MIDI)

Phrase 이 파라미터는 프레이즈 기호 설정이 포함된 MIDI 곡을 
선택한 경우에만 사용할 수 있습니다. 곡 안에서 지정한 
프레이즈를 반복해서 재생할 수 있습니다. 이 경우 
“Phrase Mark”에서 프레이즈 번호를 지정하고 
“Repeat”을 “On”으로 설정한 후 곡 재생을 시작합니다. 
“Repeat”이 “Off”일 때 곡을 재생하는 경우 이 화면의 
프레이즈 기호 번호가 전진하므로 해당 곡을 들으면서 
현재 표시된 프레이즈의 번호를 확인할 수 있습니다.
“Repeat”이 “On”인 경우 프레이즈 기호 반복 아이콘
( )이 Song 화면의 우측 상단에 표시됩니다.

On, Off Off

Song 곡 재생을 위한 반복 모드를 선택합니다.

• Off: 반복 재생을 비활성화합니다. 선택한 곡 재생이 
끝부분에 이르면 재생이 자동으로 멈춥니다.

• Single: 선택한 곡만 반복해서 재생합니다.

• All: 선택한 곡이 포함된 폴더의 모든 곡을 숫자 순으로 계속 
재생합니다.

• Random: 선택한 곡이 포함된 폴더의 모든 곡을 무작위 
순으로 계속 재생합니다.

반복 유형을 Off 이외의 다른 모드로 선택한 경우 상태 
아이콘(Single: , All: , Random: )이 Song 
화면의 우측 상단에 표시됩니다.

Off, Single, All, 
Random

Off

Volume
(MIDI)

Song – 
Keyboard

MIDI 곡 재생 음향과 건반 연주 간 음량 밸런스를 
조절합니다.

Song+64 – 0 – 
Key+64

0

Song L – R MIDI 곡 재생의 오른손 파트와 왼손 파트 간 음량 
밸런스를 조절합니다.

L+64 – 0 – R+64 0

Transpose 반음 단위로 곡 재생의 피치를 올리거나 내립니다. 예를 
들어, 이 파라미터를 “5”로 설정하는 경우 C 장조로 
생성된 곡은 F 장조로 재생됩니다. 이 설정은 건반 
피치에 영향을 미치지 않습니다.

주

• 오디오 곡을 조옮김하면 음색의 특징이 바뀔 수 있습니다.
• 외부 장치의 오디오 신호 입력은 조옮김되지 않습니다.
• MIDI 곡 재생 데이터는 조옮김된 음 번호와 함께 전송되지만 외부 

MIDI 장치나 컴퓨터에서 수신된 MIDI 음 번호는 조옮김 설정의 
영향을 받지 않습니다.

-12(-1 옥타브) – 
0(일반 피치) – 
+12(+1 옥타브) 

0

File Delete 악기 또는 연결된 USB 플래시 드라이브에 저장된 곡 
삭제, 복사, 이동과 같은 파일 작업입니다. 자세한 
내용은 “곡 파일 관리”(12페이지)를 참조하십시오.

– –

Copy
(MIDI)

Move
(MIDI)

MIDI to Audio
(MIDI)

Rename

Delete All

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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Song 메뉴
Edit
(MIDI)

Quantize 선택한 MIDI 곡의 각 음 타이밍을 맞춥니다. 예를 들어, 
4/4 박자로 음악 프레이즈를 녹음하는 경우 완벽한 
정확도로 연주하지 못할 수 있으며, 연주 파트가 정확한 
타이밍보다 약간 빠르거나 느려진 것일 수 있습니다. 
퀀타이즈는 이것을 바로잡는 편리한 방법입니다. 
자세한 내용은 “Quantize(음 타이밍 맞추기)”
(13페이지)를 참조하십시오.

– –

Track Delete 선택한 MIDI 곡에서 특정 트랙 데이터를 삭제합니다. 
자세한 내용은 “Track Delete(특정 트랙 데이터 삭제)”
(14페이지)를 참조하십시오.

– –

Tempo 
Change

선택한 MIDI 곡의 템포를 현재 템포로 변경하고 
데이터를 덮어쓰기합니다. 자세한 내용은 “Tempo 
Change(템포값 변경)”(15페이지)을 참조하십시오.

– –

Voice 
Change

선택한 MIDI 곡의 특정 트랙 음색을 현재 음색으로 
변경하고 데이터를 덮어쓰기합니다. 자세한 내용은 
“Voice Change(특정 트랙의 음색 변경)”(15페이지)을 
참조하십시오.

– –

Others
(MIDI)

Quick Play 소절의 중간에서 시작하는 곡 또는 첫 번째 음 앞에 
묵음이 있는 곡을 첫 번째 음 또는 소절(쉼표나 빈 곳)의 
처음부터 연주해야 하는지 지정할 수 있습니다. 
이 파라미터는 짧은 1 또는 2비트의 피크 업 또는 
도입부가 있는 MIDI 곡을 시작할 때 유용합니다.

On, Off On

Track Listen 선택한 MIDI 곡의 한 트랙만 재생하여 해당 내용을 
들어볼 수 있습니다. 이 경우 트랙을 선택하고 강조 
표시를 “Start”로 옮긴 다음 [r] 버튼을 길게 눌러 첫 
음부터 재생을 시작합니다. [r] 버튼을 누르고 있는 
동안에는 계속 재생됩니다.

Track 1 – 
Track 16

Track 1

Play Track 본 악기에서 재생할 수 있도록 선택한 MIDI 곡의 
트랙을 지정할 수 있습니다. “1&2”를 선택하면 트랙 1 
및 2만 재생되고, 트랙 3~16은 MIDI를 통해 연결된 
장치로 전송됩니다. “All”을 선택하면 본 악기에서 모든 
트랙이 재생됩니다.

All, 1&2 All

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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Song 메뉴
곡 파일 관리

Song 메뉴의 “File” 파라미터를 사용하면 불필요한 곡을 삭제하거나 악기의 녹음곡을 USB 플래시 드라이브로 복사하거나 다른 곡 
파일 관련 작업을 실시하여 “User” 또는 “USB” 카테고리의 곡 파일을 관리할 수 있습니다.

곡 유형 및 파일 작업의 제한
다음 표에서 곡 유형 및 파일 작업의 제한에 대해 확인할 수 있습니다. 곡 유형은 Song 화면에 카테고리 이름과 아이콘으로 
표시됩니다. 

 : 이용 가능, –: 이용 불가능

1. 필요에 따라 USB 플래시 드라이브를 USB [TO DEVICE] 단자에 연결합니다.

2. 처리할 곡을 선택합니다.

3. Song 메뉴의 “File”에서 원하는 작업을 선택합니다.

작업 설명 곡 형식

카테고리 User USB

아이콘

(MIDI) (MIDI) (Audio)

Delete 선택한 곡을 삭제합니다.   

Copy 선택한 MIDI 곡을 “User” 또는 “USB”에 복사하거나 옮깁니다.
본 악기의 “User” 카테고리에 있는 MIDI 곡은 USB 플래시 드라이브의 
“USER FILES” 폴더에만 복사하거나 옮길 수 있습니다. USB 플래시 
드라이브의 MIDI 곡은 본 악기의 “User” 카테고리로 복사하거나 옮길 수 
있습니다. 

  –

Move   –

MIDI to Audio 재생 중에 선택한 MIDI 곡을 오디오 곡으로 변환합니다.
건반 연주와 다른 오디오 입력 음향을 Bluetooth 또는 [AUX IN] 잭 등을
통해 녹음할 수 있는 오디오 녹음과 기본적으로 동일합니다.

  –

Rename 선택한 곡의 이름을 변경합니다.   

Delete All 선택한 곡이 포함된 폴더의 모든 곡을 삭제합니다.
“User” 카테고리의 곡을 선택한 경우 “User”의 모든 곡이 삭제됩니다. 
“USB” 카테고리의 곡을 선택한 경우 연결된 USB 플래시 드라이브의 
“USER FILES” 폴더에 존재하는 모든 곡이 삭제됩니다.

주
USB 플래시 드라이브의 “USER FILES” 폴더에 포함된 곡은 삭제되지 않습니다.

  

곡 이름아이콘

카테고리 이름

악기

USB 플래시 드라이브

User

복사/이동 가능

복사/이동 가능

루트

USER FILES 
폴더
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Song 메뉴
4. 선택한 작업을 실행합니다.

• “Delete”, “Copy”, “Move”, “MIDI to Audio” 또는 “Delete All”을 선택한 경우:

4-1. [r] 버튼을 눌러 작업 화면을 불러옵니다.

4-2.  [d] 버튼을 눌러 “Execute”를 선택한 후 [r] 버튼을 눌러 작업을 실행합니다.

주의사항
• 실행 중에 전원을 끄거나 USB 플래시 드라이브를 분리하지 마십시오. 모든 데이터가 사라질 수 있습니다.
• 복사/이동 대상에 이름이 동일한 곡이 이미 존재하는 경우 메시지가 나타납니다. “Overwrite”를 선택하는 경우 이미 존재하는 본래 곡 데이터가 
사라집니다.

• “Rename”을 선택하는 경우:

4-1. [r] 버튼을 눌러 작업 화면을 불러옵니다.

4-2. 곡의 이름을 변경합니다.
[l]/[r] 버튼을 사용하여 커서(밑줄)를 옮긴 후 [u]/[d] 버튼을 사용하여 현재 커서 위치의 문자를 변경합니다. 
현재 커서 위치의 문자를 삭제하려면 [REC] 버튼을 누릅니다.
곡 이름은 최대 46자까지 허용됩니다. 화면의 한계를 넘어서 보이지 않는 문자는 [l]/[r] 버튼을 사용하여 커서를 
옮기면 볼 수 있습니다.

주
곡 이름에 사용할 수 있는 문자 유형에 관한 내용은 System 메뉴의 “Utility” > “Language”(26페이지)를 참조하십시오.

4-3. [MENU] 버튼을 눌러 곡 이름을 실제로 변경합니다.

주의사항
실행 중에 전원을 끄거나 USB 플래시 드라이브를 분리하지 마십시오. 모든 데이터가 사라질 수 있습니다.

선택한 MIDI 곡 편집

Song 메뉴의 “Edit”을 통해 “User” 또는 “USB” 카테고리에서 선택한 MIDI 곡의 데이터를 변경하고 덮어쓰기할 수 있습니다.

Quantize(음 타이밍 맞추기)
이 기능을 사용하면 선택한 MIDI 곡의 각 음 타이밍을 맞출 수 있습니다. 예를 들어, 아래 표시된 음악 프레이즈를 녹음하는 경우 
완벽한 정확도로 연주하지 못할 수 있으며, 연주 파트가 정확한 타이밍보다 약간 빠르거나 느려진 것일 수 있습니다. 퀀타이즈는 
이것을 바로잡는 편리한 방법입니다.

1. 편집하려는 MIDI 곡을 선택합니다.

2. Song 메뉴의 “Edit” > “Quantize”를 선택합니다.

3. MIDI 곡의 가장 작은 음표에 “Quantize” 값을 설정합니다.

커서
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Song 메뉴
• 설정: • 8분음표 퀀타이제이션

별표(*)가 표시된 3가지 퀀타이즈 설정은 다른 두 음표 값을 동시에 퀀타이즈할 수 있기 때문에 특히 편리합니다. 예를 들어, 8분음표와 8분음표의 셋잇단음표가 
같은 파트에 들어 있을 때 8분음표별로 퀀타이즈를 하면 해당 파트의 모든 음표가 8분음표로 퀀타이즈되어 셋잇단음표의 느낌이 완전히 사라집니다. 그러나 
8분음표 + 8분음표의 셋잇단음표 설정을 사용하면 이 두 음표 모두 정확하게 퀀타이즈됩니다.

4. 음표의 퀀타이즈 강도를 결정하는 “Strength” 값을 설정합니다.
100%로 설정하면 정확한 속도 조절이 됩니다. 100% 미만의 값을 선택하면 음표가 정해진 백분율에 따라 지정된 
퀀타이제이션 비트로 이동합니다. 100% 미만의 퀀타이제이션을 적용하면 녹음 시 “인간적인” 느낌이 나도록 유지할 수 
있습니다.

5. “Execute”를 선택하고 [r] 버튼을 눌러 편집한 데이터를 저장합니다.
주의사항
[r] 버튼을 누르면 선택한 MIDI 곡의 데이터가 덮어쓰기됩니다. 중요한 데이터가 사라지지 않도록 주의하십시오.

Track Delete(특정 트랙 데이터 삭제)
이 기능을 사용하면 선택한 MIDI 곡에서 특정 트랙 데이터를 삭제할 수 있습니다.

1. 편집하려는 MIDI 곡을 선택합니다.

2. Song 메뉴의 “Edit” > “Track Delete”을 선택합니다.

3. “Track”에서 삭제할 데이터를 선택합니다.

트랙 선택 화면에서 “*” 표시는 데이터가 포함된 트랙을 의미합니다. 녹음된 데이터를 확인하려면 Song 메뉴의 “Others” > 
“Track Listen”(11페이지)을 통해 재생하십시오.

1/4................

1/8................

1/16.............

1/6................

1/12.............

1/24.............

1/8+1/12.........

1/16+1/24.......

1/32.............

1/16+1/12.......

4분음표

4분음표의 셋잇단음표

8분음표

8분음표의 셋잇단음표

16분음표

16분음표의 셋잇단음표

32분음표

8분음표 + 8분음표의 셋잇단음표*

16분음표 + 8분음표의 셋잇단음표*

16분음표 + 16분음표의 셋잇단음표*

원래 데이터

퀀타이즈 강도 = 100%

퀀타이즈 강도 = 50%

4분음표 길이
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Song 메뉴
4. “Execute”를 선택하고 [r] 버튼을 눌러 편집한 데이터를 저장합니다.
주의사항
[r] 버튼을 누르면 선택한 MIDI 곡의 데이터가 덮어쓰기됩니다. 중요한 데이터가 사라지지 않도록 주의하십시오.

Tempo Change(템포값 변경)
이 기능을 사용하면 선택한 MIDI 곡의 템포값을 변경하고 데이터를 덮어쓸 수 있습니다.

1. 편집하려는 MIDI 곡을 선택합니다.

2. [TEMPO] 버튼을 눌러 Tempo 화면을 불러온 후 원하는 템포 값으로 설정합니다.

3. Song 메뉴의 “Edit” > “Tempo Change”를 선택합니다.

4. “Execute”를 선택하고 [r] 버튼을 눌러 편집한 데이터를 저장합니다.
주의사항
[r] 버튼을 누르면 선택한 MIDI 곡의 데이터가 덮어쓰기됩니다. 중요한 데이터가 사라지지 않도록 주의하십시오.

Voice Change(특정 트랙의 음색 변경)
이 기능을 사용하면 선택한 MIDI 곡의 특정 트랙 음색을 변경할 수 있습니다.

1. 편집하려는 MIDI 곡을 선택합니다.

2. 원하는 음색을 선택합니다.

3. Song 메뉴의 “Edit” > “Voice Change”를 선택합니다.

4. “Track”에서 음색을 변경하려는 트랙을 선택합니다.

트랙 선택 화면에서 “*” 표시는 데이터가 포함된 트랙을 의미합니다. 녹음된 데이터를 확인하려면 Song 메뉴의 “Others” > 
“Track Listen”(11페이지)을 통해 재생하십시오.

5. “Execute”를 선택하고 [r] 버튼을 눌러 편집한 데이터를 저장합니다.
주의사항
[r] 버튼을 누르면 선택한 MIDI 곡의 데이터가 덮어쓰기됩니다. 중요한 데이터가 사라지지 않도록 주의하십시오.
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Metronome/Rhythm 메뉴

Metronome/Rhythm 메뉴를 사용하면 메트로놈 박자 기호와 리듬 재생 관련 파라미터와 같은 메트로놈 및 리듬 관련 파라미터를 
설정할 수 있습니다.

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정

Volume 메트로놈 또는 리듬의 음량을 결정합니다. 건반 연주와 메트로놈 또는 
리듬 재생 간 음량 밸런스를 조절할 수 있습니다.

0 – 127 82

Bell 지정된 박자 기호의 첫 박자에서 벨소리가 재생되는지 여부를 
결정합니다.

On, Off Off

Time Sig.
(박자 기호)

메트로놈의 박자 기호를 결정합니다. 자세한 내용은 “악보에 맞춰 
박자 기호 및 템포 설정”(17페이지)을 참조하십시오.

2/2, 3/2, 1/4, 2/4, 
3/4, 4/4, 5/4, 6/4, 
7/4, 3/8, 6/8, 7/8, 
9/8, 12/8

4/4
(MIDI 곡의 경우 
선택한 곡에 따라 
달라집니다.)

BPM Tempo 화면에 나타난 템포 표시 내용의 음표 유형이 위에 나타난 
메트로놈 박자 기호의 영향을 받는지 여부(영향을 받지 않을 경우 
4분)를 결정합니다. “Time Sig.”를 선택하면 박자 기호의 분모가 템포 
표시 내용의 음표 유형으로 표시됩니다. (점 4분 음표는 박자 기호가 
“6/8”, “9/8” 또는 “12/8”로 설정될 때에만 템포 표시 내용의 음표 
유형으로 표시됩니다.)

Time Sig., 
Crotchet

Time Sig.

Intro 리듬 패턴이 시작되기 전에 인트로 재생 여부를 결정합니다.

주
곡이 재생되는 동안에는 이 파라미터가 “On”으로 설정된 상태에서 리듬을 시작해도 
인트로가 재생되지 않습니다.

On, Off On

Ending 리듬 패턴이 중지되기 전에 엔딩 재생 여부를 결정합니다. On, Off On

SyncStart 이 파라미터를 “On”으로 설정한 경우, 건반에서 아무 음이나 눌러도 
리듬 재생을 시작할 수 있습니다.
이 기능이 켜져 있을 때 [RHYTHM] 버튼을 누르면 동시 시작이 대기 
상태로 설정되어 [RHYTHM] 버튼이 깜박입니다. 이 상태에서 건반을 
누르면 리듬 재생이 시작됩니다.

On, Off Off

Bass 리듬에 대한 자동 베이스 반주 켜짐 또는 꺼짐 여부를 결정합니다. On, Off On
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Metronome/Rhythm 메뉴
악보에 맞춰 박자 기호 및 템포 설정

낱장 악보에 맞춰 박자 기호 및 템포를 설정해 보십시오. “Bell”을 “On”으로 설정하는 경우 지정된 박자 기호의 첫 박자는 벨소리로 
강세가 적용됩니다.

1. Metronome/Rhythm 메뉴의 “Time Sig.”를 통해 원하는 박자 기호를 선택합니다.

2. [TEMPO] 버튼을 눌러 Tempo 화면을 불러옵니다.

3. [l]/[r] 버튼을 사용하여 템포를 설정합니다.
Tempo 화면에 “Note type=tempo value”(음표 유형 = 템포값)가 나타납니다. 1단계에서 설정한 박자 기호에 따라 음표 유형 및 
이용 가능한 템포 범위가 다음과 같이 달라집니다.

주

• 음표 유형은 Metronome/Rhythm 메뉴의 “BPM” 파라미터(16페이지)가 “Crotchet”으로 설정되어 있는 한 설정된 박자 기호와 상관없이 4분음표로 고정됩니다.
• 곡을 선택하는 경우에는 선택한 곡의 박자 기호 및 템포로 변경됩니다.

박자
음표 유형 

(한 박자 길이)
설정 범위

2/2, 3/2 2분음표
3 – 250

1/4, 2/4, 3/4, 4/4, 5/4, 6/4, 7/4 4분음표
5 – 500

6/8, 9/8, 12/8 점 4분음표
4 – 332(짝수만)

3/8, 7/8 8분음표
10 – 998(짝수만) 및 999

템포

박자 기호

음표 유형
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Recording 메뉴

Recording 메뉴를 사용하면 MIDI 녹음과 관련하여 세부적으로 설정할 수 있습니다. 이 설정은 오디오 녹음에 적용되지 않습니다.

MIDI 곡의 특정 부분 재녹음

이미 녹음된 MIDI 곡의 특정 트랙 파트를 다시 녹음할 수 있습니다. 각 트랙의 데이터를 들어보려면 Song 메뉴의 “Others” > “Track 
Listen”(11페이지)을 통해 재생하십시오.

1. Recording 메뉴에서 녹음 시작 및 정지 방법을 결정하는 파라미터를 설정합니다.

• 각 “RecStart”와 “RecEnd” 설정 조합마다 녹음된 데이터

2. 다시 녹음하려는 MIDI 곡을 선택합니다.

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정

RecStart 이 파라미터는 기존 MIDI 곡에 녹음할 때 데이터 덮어쓰기 시작 또는 
정지 타이밍을 지정합니다. 자세한 내용은 아래의 “MIDI 곡의 특정 
부분 재녹음”을 참조하십시오.

Normal, KeyOn Normal

RecEnd Replace, 
PunchOut

Replace

RecRhythm MIDI 녹음 시 리듬 재생 녹음 여부를 결정합니다. “On”으로 설정한 
경우 리듬 파트가 트랙 9~11에 녹음됩니다.

On, Off On

RecStart Normal 녹음이 시작되는 즉시 이미 녹음된 데이터가 새 데이터로 교체됩니다.

KeyOn 이미 녹음된 데이터는 건반을 누를 때까지 유지되며, 건반을 누르는 즉시 실제 녹음이 
시작됩니다.

RecEnd Replace 녹음을 멈춘 지점 이후의 데이터도 삭제됩니다.

PunchOut 녹음을 멈춘 지점 이후의 데이터는 그대로 유지됩니다.

Normal/Replace

Normal/PunchOut

KeyOn/Replace

KeyOn/PunchOut
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Recording 메뉴
3. 다시 녹음하려는 시작 지점을 지정합니다.

[l]/[r] 버튼을 사용하여 재생 위치(소절 번호)를 원하는 지점으로 옮깁니다. 또는, [PLAY/PAUSE] 버튼을 눌러 재생을 
시작한 다음 원하는 지점 약간 앞에서 [PLAY/PAUSE] 버튼을 다시 누릅니다.
필요한 경우, 설정(음색 및 기타 파라미터)을 선택합니다.

4. [REC] 버튼을 1초 동안 길게 눌러 녹음 대상 곡 목록을 불러온 후 2단계에서 선택한 곡을 다시 
선택합니다.

5. [l]/[r] 버튼을 사용하여 다시 녹음할 트랙을 선택합니다.

6. 건반을 연주하거나 [PLAY/PAUSE] 버튼을 눌러 녹음을 시작합니다.

7. [REC] 버튼을 눌러 녹음을 정지합니다.

8. “Confirm” 화면에서 “Save”를 선택하여 데이터를 저장합니다.
데이터를 저장한 후 [PLAY/PAUSE] 버튼을 눌러 녹음했던 연주를 들어봅니다.
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System 메뉴

System 메뉴를 사용하면 예를 들어 전체 악기에 적용되는 설정을 전체적으로 설정하고 USB 플래시 드라이브를 포맷하며 악기 
설정을 백업할 수 있습니다.

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정

Bluetooth Bluetooth Bluetooth 기능을 켜거나 끕니다. 스마트폰과 같은 
Bluetooth 탑재 장치에 악기를 연결하려면 이 기능을 
켜야 합니다.

주
제품을 구매한 국가에 따라 악기가 Bluetooth 기능을 지원하지 않을 수 
있습니다.

On, Off On

Pairing Bluetooth 탑재 오디오 플레이어를 등록(페어링)합니다. 
이 파라미터는 위의 “Bluetooth”가 “On”으로 설정된 
경우에만 표시됩니다.
[r] 버튼을 누르면 악기가 페어링 대기 상태로 
설정됩니다. 이는 [ ](Bluetooth) 버튼(CLP-885/CLP-
875/CLP-895GP) 또는 [MENU] 버튼(CLP-845/CLP-
835/CLP-865GP)을 3초간 길게 누를 때와 동일합니다. 
악기와 Bluetooth 탑재 오디오 플레이어 간 연결에 관한 
자세한 내용은 사용설명서를 참조하십시오.

주
(본 악기에 최대 8대의 장치를 페어링할 수 있지만) 한 번에 1개의 
스마트 장치만 본 악기에 연결할 수 있습니다. 9번째 스마트 장치와 
성공적으로 페어링한 경우 연결 날짜가 가장 오래된 장치의 페어링 
데이터가 삭제됩니다.

– –

Tuning Master Tune 전체 악기의 피치를 미세 튜닝합니다. 이 기능은 다른 
악기 또는 CD 음악과 함께 이 악기를 연주할 때 
유용합니다. 

주
이러한 설정은 드럼 키트 음색 또는 오디오 곡에 적용되지 않을 뿐더러 
MIDI 곡에 녹음되지도 않습니다.

(A3=) 414.8Hz – 
466.8 Hz
(약 0.2Hz 단위)

(A3=) 440.0Hz

Scale Tune 현대의 어쿠스틱 피아노는 거의 한 옥타브를 12개의 
동일한 구간으로 나눈 동음 평균율로만 튜닝되어 
있습니다. 마찬가지로, 본 악기 역시 동음 평균율을 
채용하고 있지만 16~19세기에 사용된 역사적인 
평균율로 연주할 수 있도록 변경할 수 있습니다.
• Equal(동음 평균율): 하나의 옥타브는 12개의 동일한 
음정으로 나뉘어집니다. 현재 가장 인기 있는 피아노 튜닝 
음계입니다.

• PureMajor, PureMinor: 이 음계를 사용하는 세 가지 
메이저 코드는 자연스러운 오버톤에 따라 아름답고 순수한 
음향을 만들어 냅니다.

• Pythag. (피타고라스 음계): 이 음계는 유명한 그리스 
철학자인 피타고라스가 고안한 것으로 단일 옥타브로 
떨어지는 일련의 완전 5도 음정에 기초하고 있습니다. 3도는 
약간 불안정하지만 4도 및 5도는 아름다워 일부 곡의 시작에 
적합합니다.

• MeanTone: 이 음계는 피타고라스 음계(Pythagorean)를 
개선하기 위해 장 3도 음정을 좀 더 잘 “조율된 상태”에 
있도록 하여 만들어졌습니다. 16세기에서 18세기 사이에 
특히 대중화되었으며, 헨델 등의 음악가들이 사용했습니다.

• Werck. (베르크마이스터), Kirnberger: 중전음률과 
피라고라스 음계를 상이한 방식으로 결합한 것입니다. 이 
음계를 사용하면 모듈레이션으로 인해 곡의 인상과 느낌이 
바뀝니다. 바흐 및 베토벤 시대에 많이 사용되었던 이 음계는 
지금도 하프시코드로 그 시대의 음악을 연주할 때 
사용됩니다.

Equal, 
PureMajor, 
PureMinor, 
Pythag., 
MeanTone, 
Werck., 
Kirnberger

Equal
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Tuning Base Note Scale Tune이 “Equal” 이외의 다른 값으로 설정된 경우 
기본음을 설정해야 합니다. 기본 음을 변경하면 건반의 
피치는 조옮김되지만 각 음 사이 본래의 피치 관계는 
유지됩니다.

C, C♯, D, E ♭ , E, 
F, F♯, G, A ♭ , A, 
B ♭ , B

C

Keyboard Touch 음향이 연주 강도에 어떻게 반응하는지 결정합니다. 
• Soft 2: 약한 연주 강도일지라도 비교적 높은 음량을 
만들어냅니다.

• Soft 1: 적당한 연주 강도로 높은 음량을 만들어냅니다.

• Medium: 표준 터치 감도입니다.

• Hard 1: 높은 음량을 내기 위해 적당히 강하게 연주해야 
합니다.

• Hard 2: 음량을 높게 하려면 강하게 연주해야 합니다.

• Fixed: 연주 강도와는 상관없이 아래의 “Fixed Velocity”에서 
설정된 음량 레벨로 고정됩니다.

주
이 설정은 MIDI 곡에 기록되지 않고 MIDI 메시지로 전송되지도 
않습니다.

Soft 2, Soft 1, 
Medium, Hard 1, 
Hard 2, Fixed

Medium

Fixed Velocity 위의 “Touch”가 “Fixed”로 설정된 경우 음이 연주되는 
세기를 결정합니다.

주
이 설정은 MIDI 곡에 기록되지 않고 MIDI 메시지로 전송되지도 
않습니다.

1 – 127 64

Duo “On”으로 설정된 경우 건반을 두 범위로 나누어 동일한 
옥타브 범위에서 이중주를 연주할 수 있습니다. 자세한 
내용은 “2명의 연주자가 동일한 옥타브 범위에서 연주
(듀엣)”(28페이지)를 참조하십시오.

On, Off Off

–Type 듀엣이 켜져 있을 때 좌측과 우측 스피커 간 음향 
밸런스를 선택합니다.
• Separated: 왼쪽 연주자가 연주하는 음향은 왼쪽 
스피커에서 출력되고 오른쪽 연주자가 연주하는 음향은 
오른쪽 스피커에서 출력됩니다.

• Balanced: 왼쪽 연주자와 오른쪽 연주자가 연주하는 
음향이 자연스러운 음향 밸런스로 두 스피커 모두에서 
출력됩니다.

주
“Separated”를 선택한 경우 Reverb(5페이지), VRM(3페이지) 및 
Binaural(23페이지)이 꺼집니다.

Separated, 
Balanced

Separated

Split Point 스플릿 또는 듀엣이 켜져 있을 때 분리점(오른손 영역과 
왼손 영역 간 경계)을 결정합니다. 지정된 분리점 
건반은 왼손 영역에 포함됩니다.
스플릿 또는 듀엣 기능이 켜져 있을 때 [DUAL/SPLIT] 
버튼을 누른 상태에서 동시에 분리점으로 설정하려는 
건반을 눌러도 분리점을 설정할 수 있습니다.

A−1 – C7 F♯2(스플릿), 
E3(듀엣)

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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Pedal Half Pedal Point 지정된 이펙트가 적용되기 시작하기 전에 오른쪽 
페달을 밟아야 하는 지점을 지정할 수 있습니다. 
이 설정은 “Sustain (Cont.)” 기능(7페이지)이 오른쪽 
페달에 지정된 경우에만 적용됩니다.

−2(가장 살짝 
밟으면 작동)
– 0 – +4(가장 
깊게 밟으면 
작동)

0

Soft Pedal Depth 소프트 페달 이펙트가 적용되는 깊이를 결정합니다. 
이 파라미터는“Soft”(7페이지)가 지정된 페달에만 
사용할 수 있습니다.

1 – 10 5

Pitch Bend 
Range

반음 단위로 페달을 통해 생성된 피치 벤드의 범위를 
결정합니다. 이 설정은 “PitchBend Up” 또는 “PitchBend 
Down”(7페이지)이 지정된 페달에만 사용할 수 
있습니다.

주
일부 음색의 경우는 여기에서 설정된 피치 벤드 범위 값에 따라 피치가 
변하지 않을 수 있습니다.

0 – +12(페달을 
밟으면 피치가 
12반음씩 올라

가거나 내려감)

2

Play/Pause 제어 패널의 [PLAY/PAUSE] 버튼 기능을 왼쪽 또는 
중앙 페달에 지정합니다. 여기에서 “Off” 이외의 다른 
값을 선택하면 “Voice” 메뉴(7페이지)에서 지정된 해당 
페달의 기능이 비활성화됩니다.

Off, Left, Center Off

Sound Brilliance 본 악기의 전체 음향 밝기를 조절합니다. 이 설정은 
건반 음색, 곡 재생, 외부 장치의 MIDI 입력에 
공통적으로 적용됩니다.
• Mellow 1 – 3: 부드럽고 매끄러운 톤. 숫자가 높아질수록 
음향이 더욱 부드럽고 따뜻해집니다.

• Normal: 표준 톤.

• Bright 1 – 3: 밝은 톤. 숫자가 높아질수록 음향이 더욱 
밝아집니다.

• User: 자신만의 맞춤 EQ 설정을 생성할 수 있는 “User” 
화면을 엽니다. 
EQ(이퀄라이저)는 전체 
주파수 응답에 맞추는 데 
필요한 만큼 높이거나 낮출 
수 있는 다중 대역으로 
주파수 스펙트럼을 
분할하는 사운드 프로세서
입니다. 본 악기를 
사용하면 3개 주파수 대역(저/중/고)의 게인을 조절할 수 
있습니다. 
• 설정 범위: −6 dB – 0 – +6 dB
• 기본 설정: 0dB

Mellow 1 – 3, 
Normal, 
Bright 1 – 3, 
User

Normal

IAC IAC(지능형 어쿠스틱 컨트롤) 이펙트를 켜거나 끕니다. 
IAC는 악기의 전체 음량에 따라 음질을 자동으로 조절 
및 제어하는 기능으로, 악기 스피커 또는 헤드폰의 음향 
출력에서만 작동합니다. IAC를 사용하면 음량이 낮을 
때에도 저음과 고음을 선명하게 들을 수 있습니다. 특히 
헤드폰을 사용할 때 전체 음량을 과도하게 높이지 않아 
귀에 가해지는 부담이 감소합니다.

On, Off On

–Depth IAC의 깊이를 결정합니다. 값이 커질수록 낮은 음량 
레벨에서도 저음과 고음이 더욱 선명해집니다.

−3 – +3 0

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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Sound Binaural Binaural Sampling 기능을 켜거나 끕니다. VRM 
이펙트가 적용된 음색의 경우 이 기능이 켜져 있을 때 
헤드폰을 연결하면 본 악기의 음향이 Binaural 
Sampling 음향 또는 Stereophonic Optimizer로 강화된 
음향으로 변경되어 보다 실감나는 음향을 감상할 수 
있습니다.

 Binaural Sampling
(“CFX Grand” 및 “Bösendorfer” 음색만 해당)

Binaural Sampling은 2개의 특수 마이크를 연주자의 귀 위치에 
설치하여 피아노 음향을 그대로 녹음하는 방법입니다. 
이 이펙트를 사용하여 헤드폰을 통해 음향을 들으면 실제로 
피아노에서 흘러나오는 것처럼 음향에 둘러싸인 듯한 느낌을 
받을 수 있습니다 해당 음색 중 하나를 선택한 경우 헤드폰을 
연결하면 Binaural Sampling 음향이 자동으로 활성화됩니다.

 Stereophonic Optimizer
(“CFX Grand” 및 “Bösendorfer”를 제외한 
VRM 이펙트가 적용된 음색만 해당)

Stereophonic Optimizer는 헤드폰을 통해 들어도 Binaural 
Sampling의 음향과 같이 자연스러운 음향 거리감을 재현하는 
이펙트입니다. 해당 음색 중 하나를 선택한 경우 헤드폰을 
연결하면 자동으로 Stereophonic Optimizer가 작동됩니다.

주

• System 메뉴의 “Utility” > “Speaker”(25페이지)가 “On”으로 설정되면 
헤드폰을 연결할 때에도 이 기능이 비활성화됩니다.

• Binaural이 “On”으로 설정된 경우 헤드폰을 연결하면 이러한 
이펙트는 AUX OUT 잭에 연결된 외부 스피커의 음향 또는 오디오 
녹음 음향에도 영향을 미쳐 이상하거나 부자연스럽게 들릴 수 
있습니다. 이 경우 이 기능을 끄십시오.

On, Off On

Volume Limiter 음량 제한기를 켜거나 끕니다. “On”으로 설정한 경우 
전체 음향의 최대 음량은 매우 큰 음량을 방지할 수 
있도록 제한되며, 아이콘( )이 Song 화면 또는 
Voice 화면 우측 하단에 나타납니다.

On, Off Off

–Limit 
Point

음량 제한기 기능이 켜지면 최대 음량을 결정합니다. 
설정값이 [VOLUME] 슬라이더 위치(MAX = 100%)를 
표시합니다. 슬라이더를 이 지점 너머로 움직이더라도 
음량 레벨이 커지지 않습니다.

10% – 100% 50%

MIDI MIDI OUT 건반 연주를 통해 생성된 MIDI 메시지가 USB [TO 
HOST] 단자에서 전송되는 MIDI 채널을 결정합니다. 
듀얼/스플릿/듀엣 기능이 켜져 있을 때 MIDI 채널은 
다음과 같이 지정됩니다.
• 오른손 1 음색을 통한 연주 = n(설정 값)

• 오른손 2 음색을 통한 연주 = n+2

• 왼손 음색을 통한 연주 = n+1

Ch1 – Ch16, Off
(전송되지 않음)

Ch1

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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MIDI MIDI IN USB [TO HOST] 단자에서 전송되는 MIDI 메시지의 
각 채널 데이터에 의해 제어되는 악기의 파트를 
결정합니다.
• Song: 곡 파트가 제어됩니다.

• Keyboard: 전체 건반 연주가 Dual/Split/Duo 설정과는 
상관없이 제어됩니다.

• R1: 오른손 1 음색을 통한 건반 연주가 제어됩니다.

• R2: 오른손 2 음색을 통한 건반 연주가 제어됩니다.

• L: 왼손 음색을 통한 건반 연주가 제어됩니다.

• Off: 제어되는 파트가 없습니다.

Song, Keyboard, 
R1, R2, L, Off

(모든 채널에 
해당)
곡

Local Control “Local Control On” 상태는 건반을 연주할 때 본 악기가 
톤 제너레이터에서 음향이 생성하고 있음을 뜻합니다. 
“Local Control Off” 상태에서는 건반과 톤 제너레이터가 
서로 차단됩니다. 즉, 건반을 연주하더라도 본 악기에서 
어떠한 음향도 생성되지 않습니다. 대신, 음향을 생성할 
수 있는 연결된 MIDI 장치 또는 컴퓨터에 MIDI를 통해 
연주 데이터를 전송할 수 있습니다. “Local Control Off” 
설정은 본 악기의 건반을 연주하면서 외부 음원을 
연주하려는 경우에만 유용합니다.

On, Off On

Receive Param.
(Parameter)

본 악기에서 수신되거나 인식될 수 있는 MIDI 메시지의 
유형을 결정합니다.

MIDI 메시지 유형
Note on/off, Control Change, Program Change, Pitch Bend, 
System Exclusive

On, Off (모든 메시지에 
해당)
On

Transmit Param.
(Parameter)

본 악기에서 전송 가능한 MIDI 메시지의 유형을 
결정합니다.

MIDI 메시지 유형
Note on/off, Control Change, Program Change, Pitch Bend, 
System Real Time, System Exclusive

On, Off (모든 메시지에 
해당)
On

Initial Setup 연결된 MIDI 장치 또는 컴퓨터에 음색 선택과 같이 
악기의 현재 설정을 전송합니다. 연결된 MIDI 장치 또는 
컴퓨터에 연주 녹음을 시작하기 전에 이 작업을 
실행하여 연주 데이터 시작 부분에 현재 패널 설정을 
저장합니다. 그러면 녹음한 연주를 재생할 때 동일한 
패널 설정이 호출됩니다.
이 기능을 사용하려면 “Execute”를 선택한 후 
[r] 버튼을 눌러 MIDI 메시지로 악기 설정을 
전송합니다.

– –

Backup Backup Setting 전원이 꺼진 경우 설정이 유지될지 설정할 수 있습니다. 
자세한 내용은 “전원이 꺼질 때 유지될 파라미터 선택
(Backup Setting)”(29페이지)을 참조하십시오.

On, Off “Voice” = Off
“Other” = On

Backup 연결된 USB 플래시 드라이브에 백업 파일(extension: 
.bup)로 악기에 모든 사용자 곡 데이터 및 설정을 
저장할 수 있습니다. 자세한 내용은 
“USB 플래시 드라이브에 곡 데이터 및 악기 설정 저장
(백업)”(29페이지)을 참조하십시오.

– –

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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System 메뉴
Backup Restore USB 플래시 드라이브의 백업 파일(extension: .bup)을 
악기에 불러오고 사용자 곡 및 설정을 복구할 수 
있습니다. 자세한 내용은 
“USB 플래시 드라이브에 저장된 백업 파일을 악기에 
불러오기(Restore)”(30페이지)를 참조하십시오.

– –

Factory Reset 백업 설정을 출고 시 기본값으로 재설정할 수 있습니다. 
자세한 내용은 “출고 시 프로그램된 설정 복원(Factory 
Reset)”(30페이지)을 참조하십시오.

– –

Utility Speaker 악기 스피커를 켜고 끌 수 있습니다.
• Normal: 헤드폰이 [PHONES] 잭에 연결되지 않은 경우에만 
스피커에서 소리가 들립니다.

• On: 스피커 소리가 항상 켜집니다.

• Off: 스피커 소리가 꺼집니다.

주
“On”으로 설정된 경우 “Binaural”(23페이지)이 비활성화됩니다.

Normal, On, Off Normal

Audio Loopback 연결된 컴퓨터나 스마트 장치의 오디오 입력 음향을 
악기 연주와 함께 컴퓨터나 스마트 장치에 출력할지 
여부를 결정합니다.
예를 들어, 연결된 컴퓨터나 스마트 장치를 사용하여 
오디오 입력 음향과 악기 연주 음향을 녹음하려는 
경우에는 이 기능을 “On”으로 설정하고, 컴퓨터나 
스마트 장치를 사용해 악기에서 연주한 음향만을 
녹음하려면 이 기능을 “Off”로 설정합니다.

주

• 본 설명서에서 “오디오 입력 음향”은 USB 오디오 인터페이스 기능, 
Bluetooth 오디오 기능, [AUX IN] 잭 또는 Wi-Fi 중 하나를 사용하여 
연결된 외부 장치에서 악기로 입력되는 오디오 데이터를 의미합니다.

• Bluetooth 또는 [AUX IN] 잭을 통해 연결된 장치로는 음향을 출력할 수 
없습니다.

• 본 악기의 오디오 녹음을 사용하는 경우, 이 기능이 “On”으로 
설정되어 있으면 외부 장치의 오디오 입력 음향이 녹음되고 
“Off”로 설정되어 있으면 녹음되지 않습니다. 그러나 장치를 
Bluetooth Audio 또는 [AUX IN] 잭을 통해 연결한 경우, 입력 음향은 
오디오 루프백 켜짐/꺼짐 설정에 관계없이 항상 녹음됩니다.

On, Off On

Auto Power Off 오토 파워 오프 기능으로 전원이 꺼질 때까지 경과되는 
시간을 설정할 수 있습니다. 오토 파워 오프를 작동 
중지시키려면 “Off”를 선택합니다.
오토 파워 오프 기능을 작동 중지시켜도 가장 낮은 
건반을 누른 상태에서 전원을 켤 수 있습니다.

주의사항
악기의 전원이 자동으로 꺼지면 저장되지 않은 모든 데이터는 
손실됩니다. 이와 같은 상황이 발생하기 전에 반드시 데이터를 
저장하십시오.

Off, 5, 10, 15, 30, 
60, 120(분)

15

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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System 메뉴
Utility USB Properties USB [TO DEVICE] 단자에 연결된 USB 플래시 
드라이브의 사용 가능한 공간과 전체 메모리의 용량을 
표시합니다. 

– –

USB Autoload 이 파라미터가 “On”으로 설정되어 있는 경우, USB 
플래시 드라이브를 USB [TO DEVICE] 단자에 연결하는 
즉시 루트 디렉토리에 저장된 곡을 자동으로 선택할 수 
있습니다(화면에 표시).

On, Off Off

USB Format USB [TO DEVICE] 단자에 연결된 USB 플래시 
드라이브를 포맷하거나 초기화할 수 있습니다. 포맷을 
시작하려면 “Execute”를 선택한 다음 [r] 버튼을 
누릅니다. 포맷이 완료되면 잠시 후 악기가 Utility 
화면으로 돌아간다는 메시지가 나타납니다.

주의사항
• 포맷 작업을 실행하면 USB 플래시 드라이브에 저장된 모든 
데이터가 삭제됩니다. 중요한 데이터는 컴퓨터나 다른 저장 
장치에 저장하십시오.

• 화면에 “Executing” 메시지가 표시되어 있으면 절대 USB 
플래시 드라이브 전원을 끄거나 분리하지 마십시오. USB 플래시 
드라이브 데이터가 손상될 수 있습니다.

– –

Contrast 화면의 대비를 조절합니다. −8 – +8 0

Touch Panel 
Sound
(CLP-885/CLP-875/
CLP-895GP)

제어 패널을 작동하면 편리하게 확인음이 나는데, 
여기에서 켜거나 끌 수 있습니다.

On, Off On

Auto Backlight 
Off
(CLP-885/CLP-875/
CLP-895GP)

컨트롤 패널과 화면이 꺼질 때까지 경과되는 시간을 
설정하거나 시간 제한 없이 계속 켜지도록 설정할 수 
있습니다(“Off” 설정).

Off, 10, 20, 30, 
60(초)

30

Language System(곡명 이외의 일반 설정)과 Song(곡 이름) 
화면에 개별적으로 표시되는 문자 형식을 결정합니다.

문자 목록: 

International, 
Japanese

International

Version 본 악기의 모델명과 펌웨어 버전을 표시합니다. – –

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정

전체 메모리 
용량

사용 가능한 
공간 용량

International

Japanese
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System 메뉴
Utility Wireless LAN
* USB 무선 LAN 어댑터가 
연결되어 있을 때에만 
나타납니다.

무선 LAN(Wi-Fi) 관련 설정을 실시할 수 있습니다. 
자세한 내용은 31페이지를 참조하십시오.

– –

Wire-
less 
LAN 
Option
* USB 

무선 LAN 
어댑터가 
연결되어 
있을 
때에만 
나타납니다.

Wireless 
LAN 
Mode

액세스 포인트를 사용할지(Infrastructure Mode) 
사용하지 않을지(Accesspoint Mode) 결정합니다.

Infrastructure 
Mode, 
Accesspoint 
Mode

Infrastructure 
Mode

Initialize 무선 LAN 설정을 초기화합니다. “Execute”를 선택하고 
[r] 버튼을 눌러 설정을 초기화합니다.

– –

Detail 호스트 이름, MAC 주소 및 네트워크 상태를 
표시합니다. 호스트 이름을 변경할 수 있습니다. 문자 
입력 방법은 곡 파일의 “Rename”(12페이지)에서와 
동일합니다.

(호스트 이름)
영숫자 문자, “_”
(밑줄 표시) 및 
“-”(하이픈) 
문자를 포함한 
최대 57개의 문자
(반자)

(호스트 이름)
CLP-***-xxxxxx 
(MAC 주소의 
마지막 6자리 
숫자)

작동법
[MENU] 버튼을 몇 차례 눌러 Voice 메뉴를 선택한 다음 [u]/[d]/[l]/[r] 버튼을 사용하여 원하는 파라미터를 선택하고 설정을 
변경합니다.

파라미터 설명 설정 범위 기본 설정
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System 메뉴
2명의 연주자가 동일한 옥타브 범위에서 연주(듀엣)

이 기능을 사용하면 두 연주자 중 한 사람은 왼쪽, 한 사람은 오른쪽에서 악기를 연주할 수 있습니다. 이는 동일한 옥타브 범위에서 
이중주를 연습할 때 편리합니다.

1. System 메뉴의 “Keyboard” > “Duo”를 통해 듀엣 기능을 켭니다.
CLP-885/CLP-875/CLP-895GP의 경우 [DUAL/SPLIT] 버튼이 주황색으로 변하고, CLP-845/CLP-835/CLP-865GP의 경우 
[DUAL/SPLIT] 버튼이 켜집니다. 건반은 E3 건반을 분리점으로 하여 두 부분으로 나뉩니다. 분리점 건반은 왼손 연주자의 
영역에 포함됩니다. 

주
System 메뉴의 “Keyboard” > “Split Point”(21페이지)를 통해 분리점을 설정할 수 있습니다.

페달 기능은 다음과 같이 변경됩니다.
• 오른쪽 페달: 오른손 연주자의 댐퍼 페달

• 중앙 페달: 오른손과 왼손 연주자 모두에 대한 댐퍼 페달

• 왼쪽 페달: 왼손 연주자에 대한 댐퍼 페달

2. 필요에 따라 [EXIT] 버튼을 눌러 Voice 화면을 불러온 후 [l]/[r] 버튼 또는 [VOICE] 버튼을 사용하여 
원하는 음색을 선택합니다.
듀엣 기능이 켜져 있으면 음색 화면에 [Duo] 표시가 나타납니다. 오른손/왼손 연주자 모두에 1개(공유)의 음색만 선택할 수 
있습니다.

3. 건반을 연주합니다.
기본적으로 왼쪽 연주자의 음향은 왼쪽 스피커에서 출력되고, 오른쪽 연주자의 음향은 오른쪽 스피커에서 출력됩니다.

주

•  System 메뉴의 “Keyboard” > “Duo-Type”(21페이지)을 통해 “Balanced”로 설정하는 경우 오른손/왼손 연주자 모두 연주하는 음향이 자연스러운 음향 밸런스로 
두 스피커 모두를 통해 출력될 수 있습니다.

• 듀엣 기능이 켜지면 VRM 이펙트(3페이지)가 적용되지 않습니다. System 메뉴의 “Keyboard” > “Duo-Type”(21페이지)을 “Separated”로 설정하는 경우 Reverb
(5페이지) 및 Binaural(23페이지) 이펙트도 적용되지 않습니다.

4. 듀엣 기능을 끄려면 [DUAL/SPLIT] 버튼을 누릅니다.
주
[CFX GRAND], [BOSENDORFER] 또는 [PIANO ROOM] 버튼 중 하나를 누르거나 위의 1단계에서 화면의 “Off”를 선택해도 듀엣 기능을 끌 수 있습니다.

분리점 E3

왼쪽 연주자

C3에 해당(중간 C)C3에 해당(중간 C)

오른쪽 연주자
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System 메뉴
전원이 꺼질 때 유지될 파라미터 선택(Backup Setting)

다음 데이터와 설정(백업 데이터)은 전원이 꺼져도 유지됩니다. “Backup Setting”에 포함된 파라미터의 경우 전원이 꺼질 때 설정 
유지 여부와 관련하여 설정할 수 있습니다.

1. System 메뉴의 “Backup” > “Backup Setting”을 불러옵니다.

2. “Voice”와 “Other” 각각에 “On”(데이터 유지) 또는 “Off”(데이터 미유지)를 선택합니다.

• “Voice”에 포함된 파라미터:
• 음색 선택

• Voice 메뉴에서 “Transpose” 이외의 다른 모든 파라미터

• “Other”에 포함된 파라미터:
• Song 메뉴: Repeat, Volume (Song- Keyboard), Volume (Audio Song), Quick Play, Play Track

• Metronome/Rhythm 메뉴: Volume, Bell, BPM, Intro, Ending, Bass

• System 메뉴: Tuning, Keyboard(Duo 및 Duo Type 제외), Pedal, Sound, MIDI

3. 설정 후 [EXIT] 버튼을 눌러 System 메뉴를 종료합니다.

USB 플래시 드라이브에 곡 데이터 및 악기 설정 저장(백업)

“User” 카테고리에 저장된 곡 데이터와 악기 설정을 USB 플래시 드라이브에 백업 파일(extension: .bup)로 저장할 수 있습니다. 
추후 불러올 수 있도록 복구 기능(30페이지)을 사용하면 이 백업 파일을 악기에 불러올 수 있습니다. 백업 파일에 포함된 특정 
데이터에 관한 내용은 위의 “백업 데이터”를 참조하십시오.

주의사항
• 동일한 백업 파일(clp-***.bup)이 USB 플래시 드라이브에 이미 저장되어 있는 경우, 이 작업을 실시하면 이 백업 파일로 덮어쓰기되거나 새로운 백업 
파일로 대체됩니다.

• 이 작업을 완료하려면 1~2분이 소요될 수 있습니다. “Executing” 메시지가 표시된 동안에는 전원을 끄지 마십시오. 데이터가 손상될 위험이 있습니다.

1. USB 플래시 드라이브를 USB [TO DEVICE] 단자에 연결합니다.

2. System 메뉴의 “Backup” > “Backup”을 불러옵니다.

3. “Execute”를 선택하고 [r] 버튼을 눌러 USB 플래시 드라이브에 데이터를 저장하기 시작합니다.
데이터가 저장되면 작업이 완료되었다고 알리는 메시지가 나타납니다.

백업 데이터

• “User” 카테고리에 저장된 MIDI 곡

• System 메뉴의 다음 설정

- “Bluetooth” > “Bluetooth”(20페이지)

- “Keyboard” > “Duo-Type”(21페이지)

- “Utility”(25페이지)

- “Backup” > “Backup Setting”에서 “On”으로 설정된 파라미터 
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System 메뉴
USB 플래시 드라이브에 저장된 백업 파일을 악기에 불러오기(Restore)

USB 플래시 드라이브에 저장된 백업 파일(extension: .bup)을 불러오면 사용자 곡과 악기 설정을 복구할 수 있습니다.

주의사항
• 악기의 “User” 위치에 곡이 존재하는 경우 복구 작업을 실행하면 해당 곡 모두 삭제됩니다. 이 작업을 실행하기 전에 반드시 Song 메뉴의 “File” > 

“Move”(10페이지)를 통해 USB 플래시 드라이브에 중요한 데이터를 옮기십시오.
• 이 작업을 완료하려면 1~2분이 소요될 수 있습니다. “Executing” 메시지가 표시된 동안에는 전원을 끄지 마십시오. 데이터가 손상될 위험이 있습니다.

1. 백업 파일이 포함된 USB 플래시 드라이브를 USB [TO DEVICE] 단자에 연결합니다.

2. System 메뉴에서 “Backup” > “Restore”를 불러옵니다.

3. “Execute”를 선택하고 [r] 버튼을 눌러 악기에 데이터를 불러오기 시작합니다.
작업이 완료되었다고 알리는 메시지가 나타납니다. 그러면 잠시 후 악기가 재시작됩니다.

출고 시 프로그램된 설정 복원(Factory Reset)

출고 시 설정 복원 기능을 사용하면 출고 시 기본값으로 악기 설정이 초기화됩니다. “User” 카테고리에 저장된 MIDI 곡과 Bluetooth 
페어링 정보는 출고 시 설정 복원 작업을 실행해도 사라지지 않습니다.

주의사항
화면에 “Executing” 메시지가 표시된 동안에는 전원을 끄지 마십시오. 데이터가 손상될 위험이 있습니다.

1. System 메뉴에서 “Backup” > “Factory Reset”을 불러옵니다.

2. “Execute”를 선택하고 [r] 버튼을 눌러 초기화를 시작합니다.
작업이 완료되었다고 알리는 메시지가 나타납니다. 그러면 잠시 후 악기가 재시작됩니다.

주
“User”에 저장된 모든 MIDI 곡은 Song 메뉴의 “File” > “Delete All”을 통해 삭제할 수 있습니다. 자세한 내용은 “곡 파일 관리”(12페이지)를 참조하십시오.

출고 시 설정 복원 대신 사용되는 방법 
다음 방법을 통해서도 출고 시 프로그램된 설정을 복원할 수 있습니다.
가장 높은 건반을 누른 상태에서 [P](대기/켜짐) 스위치를 눌러 전원을 켭니다.

가장 높은 건반

[P](대기/켜짐) 스위치
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무선 LAN(Wi-Fi) 설정 실시

무선 LAN(Wi-Fi)을 통해 스마트 장치에 악기를 연결하려면 별매 USB 무선 LAN 어댑터 UD-WL01이 필요합니다.

주의사항
본 악기를 공용 Wi-Fi 및 인터넷 서비스에 직접 연결하지 마십시오. 강력한 암호로 보호되는 라우터를 통해서만 본 악기를 인터넷에 연결하십시오. 
최적의 보안 실천에 관한 내용은 라우터 제조업체에 문의하십시오.

주
USB 무선 LAN 어댑터(UD-WL01)는 지역에 따라 판매되지 않을 수도 있습니다.

1. 본 악기의 USB [TO DEVICE] 단자에 USB 무선 LAN 어댑터 UD-WL01을 연결합니다.

2. System 메뉴의 “Utility” > “Wireless LAN Option” > “Wireless LAN Mode”에서 연결 모드를 
선택합니다.

3. System 메뉴의 “Utility” > “Wireless LAN”에서 필요한 설정을 실시합니다.
화면에 표시된 파라미터는 “Infrastructure Mode”와 “Accesspoint Mode”가 서로 다릅니다. Infrastructure Mode에 관한 내용은 
아래를 참조하고 Accesspoint Mode는 32페이지를 참조하십시오.

• Infrastructure Mode:
“Select Network”를 통해 목록에서 원하는 네트워크를 선택하십시오. 목록에 표시되지 않은 네트워크에 연결하려는 경우 
목록 맨 끝의 “Other”를 선택합니다. “Other”를 선택할 때 SSID, 보안 및 비밀번호 설정을 실시한 후 “Connect”를 선택하여 
실행합니다.

필요에 따라 “Wireless LAN” 화면으로 돌아가 “Detail” 설정을 실시합니다. “Detail” 화면에서 설정을 실시한 후에는 반드시 
“Save”를 실행하여 저장하십시오.

Infrastructure Mode 이 모드는 USB 무선 LAN 어댑터(UD-WL01)와 네트워크 간 데이터 통신에 액세스 포인트를 
사용합니다. 스마트 장치가 악기에 연결되어 있는 상태에서 다른 네트워크에 연결할 때 
사용할 수 있습니다.
• 액세스 포인트가 WPS를 지원하는 경우:
악기에서 설정을 실시할 필요가 없습니다. USB 무선 LAN 어댑터의 WPS 버튼을 3초 이상 
누른 후 2분 안에 액세스 포인트의 WPS 버튼을 누릅니다.
주 
액세스 포인트 설정 확인 및 변경에 관한 내용은 액세스 포인트 설명서를 참조하십시오.

• 액세스 포인트가 WPS를 지원하지 않는 경우(혹은 잘 모르는 경우):
악기에 표시된 네트워크 목록에서 연결하려는 항목을 선택합니다.

Accesspoint Mode 이 모드를 사용하면 액세스 포인트 없이도 USB 무선 LAN 어댑터와 스마트 장치를 직접 
연결할 수 있습니다. 악기에 연결 시에 사용 가능한 액세스 포인트가 없거나, 스마트 장치가 
악기에 연결된 상태에서 또 다른 네트워크에 연결할 필요가 없을 때 이 모드를 사용할 수 
있습니다.

파라미터 설명 설정 범위 기본 설정

Select 
Network

(네트워크) 네트워크를 선택하여 액세스 포인트에 
연결합니다. 잠금 아이콘( ) 표시가 있는 
네트워크에는 적절한 비밀번호를 입력해야 
합니다. 문자 입력 방법은 곡 파일의 
“Rename”(13페이지)에서와 동일합니다.

– –
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• 액세스 포인트 모드의 경우:
SSID, 보안, 비밀번호 및 채널 설정을 실시하여 액세스 포인트로 악기를 사용합니다. 이 화면에서 설정을 실시한 후에는 
반드시 “Save”를 실행하여 저장하십시오. 

Select 
Network

Other SSID SSID를 설정합니다. 문자 입력 방법은 
곡 파일의 “Rename”(13페이지)에서와 
동일합니다.

최대 32개 문자(반자), 
영숫자 문자, 기호

–

Security 보안을 설정합니다. NONE, WEP, 
WPA2-PSK(AES), 
WPA/WPA2 mixed 
PSK

NONE

Password 비밀번호를 설정합니다. 문자 입력 방법은 
곡 파일의 “Rename”(13페이지)에서와 
동일합니다.

최대 64개 문자(반자), 
영숫자 문자, 기호

–

Connect “Other” 화면에서 실시한 설정으로 
네트워크를 연결합니다.

– –

Detail DHCP 무선 LAN의 세부 설정을 실시합니다. 
DHCP가 Off로 설정되어 있으면 IP 
Address, Subnet Mask, Gateway, DNS 
Server1, DNS Server2를 설정할 수 있으나 
On인 경우에는 설정할 수 없습니다. 
[l]/[r] 버튼을 사용하여 입력 화면에서 
각각의 옥텟을 선택한 다음 [u]/[d] 버튼을 
사용하여 값을 입력합니다. 설정을 
마치려면 [MENU] 버튼을 누릅니다.

On/Off On

IP Address 0.0.0.0-
255.255.255.255

0.0.0.0

Subnet Mask 0.0.0.0-
255.255.255.255

0.0.0.0

Gateway 0.0.0.0-
255.255.255.255

0.0.0.0

DNS Server 1, 2 0.0.0.0-
255.255.255.255

0.0.0.0

Save “Detail” 화면에서 설정을 저장합니다. – –

파라미터 설명 설정 범위 기본 설정

SSID SSID를 액세스 포인트로 설정합니다. 문자 
입력 방법은 곡 파일의 “Rename”(13페이지)
에서와 동일합니다.

최대 32개 문자(반자), 
영숫자 문자, 기호

ap-CLP-***-
xxxxxx(MAC 주소의 
마지막 6자리 숫자)

Security 보안을 액세스 포인트로 설정합니다. NONE, WEP, 
WPA2-PSK(AES), 
WPA/WPA2 mixed PSK

NONE

Password 비밀번호를 액세스 포인트로 설정합니다. 
문자 입력 방법은 곡 파일의 “Rename”
(13페이지)에서와 동일합니다.

최대 64개 문자(반자), 
영숫자 문자, 기호

–

Channel 채널을 액세스 포인트로 설정합니다. USB 무선 LAN 어댑터 모델에 
따라 다릅니다.
• 미국 및 캐나다 모델: 1–11
• 그 외: 1~13
USB 무선 LAN 어댑터가 
연결되어 있지 않으면 설정 
범위는 채널 1~13입니다.

11

파라미터 설명 설정 범위 기본 설정
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DHCP Server IP 주소 관련 사항을 설정합니다. On, Off On

IP Address 192. 168. 0-255. 1-254. 192.168.0.1

Subnet Mask 255.255.0.0,
255.255.128.0,
255.255.192.0,
255.255.224.0,
255.255.240.0,
255.255.248.0,
255.255.252.0,
255.255.254.0,
255.255.255.0

255.255.255.0

Save “Wireless LAN” 화면(액세스 포인트 모드의 
경우)에서 실시한 설정을 저장합니다.

– –

파라미터 설명 설정 범위 기본 설정
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